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1) Squash and Stretch 

Squash and stretch is debatably the most fundamental principle. Look at what happens 

when a ball hits the ground. The force of the motion squashes the ball flat, but because an 

object needs to maintain its volume, it also widens on impact. This what’s called squash and 

stretch. 



 

 

2) Anticipation 

Imagine you’re about to kick a soccer ball. What’s the first thing you do? Do you swing 

your foot back to wind up? Steady yourself with your arms? That’s anticipation. 

 

Anticipation is the preparation for the main action. The player striking the soccer ball would 

be the main action, and the follow-through of the leg is well… the follow through. 

3) Staging 

When filming a scene, where do you put the camera? Where do the actors go? What do you 

have them do? The combination of all these choices is what we call staging. 

 

Staging is one of the most overlooked principles. It directs the audience’s attention toward 

the most important elements in a scene in a way that effectively advances the story. 

 

 

 

 



4) Straight Ahead Action and Pose-to-Pose 

These are two ways of drawing animation. Straight ahead action is where you draw each 

frame of an action one after another as you go along. With pose-to-pose, you draw the 

extremes – that is, the beginning and end drawings of action – then you go on to the middle 

frame, and start to fill in the frames in-between. 

 

Pose-to-pose gives you more control over the action. You can see early on where your 

character is going to be at the beginning and end instead of hoping you’re getting the timing 

right. By doing the main poses first, it allows you to catch any major mistakes early. The 

problem with it is that sometimes it’s too neat and perfect 

 

Straight ahead action is less planned, and therefore more fresh and surprising. The problem 

with it is that it’s like running blindfolded… you can’t figure out where you’re supposed to 

be at any one time. 

 

Mastering both techniques and combining them is the best approach to being a successful 

animator because then you can get both structure and spontaneity.  And incidentally, this 

distinction is just as important in computer animation, where molding a pose at each 

keyframe is the equivalent of making a drawing. 

 

5) Follow-Through and Overlapping Action 

When a moving object such as a person comes to a stop, parts might continue to move in 

the same direction because of the force of forward momentum. These parts might be hair, 

clothing, jowls, or jiggling flesh of an overweight person. This is where you can see 

follow- through and overlapping action. The secondary elements (hair, clothing, fat) are 

following- through on the primary element, and overlapping its action. 

 



Follow-through can also describe the movement of the primary element though. If you land 

in a crouch after a jump, before standing up straight, that’s follow-through. 

6) Ease In, Ease Out 

When you start your car, you don’t get up to 60 mph right away. It takes a little while to 

accelerate and reach a steady speed. In animation speak, we would call this an Ease Out. 

 

Likewise, if you brake, you’re not going to come to a full stop right away. (Unless you crash 

into a tree or something.) You step on the pedal and decelerate over a few seconds until you 

are at a stand-still. Animators call this an Ease In. 

 

Carefully controlling the changing speeds of objects creates an animation that has a superior 

believability. 

 



7) Arcs 

Life doesn’t move in straight lines, and neither should animation. Most living beings – 

including humans – move in circular paths called arcs. 

 

Arcs operate along a curved trajectory that adds the illusion of life to an animated object in 

action. Without arcs, your animation would be stiff and mechanical. 

 

The speed and timing of an arc are crucial. Sometimes an arc is so fast that it blurs beyond 

recognition. This is called an animation smear – but that’s a topic for another time. 

 

 

In the above example from Scandis, the man passes the cash along from one person to 

another by reaching his arms across the frame. At first glance it may be hard to see the arcs 

happening, but when it’s outlined on the second time around it’s quite obvious. The fluid 

arcing motion of the arms adds grace to the animation. 

8) Secondary Action 

Secondary actions are gestures that support the main action to add more dimension to 

character animation. They can give more personality and insight to what the character is 

doing or thinking. 

10) Exaggeration 

Sometimes more is more. Exaggeration presents a character’s features and actions in an 

extreme form for comedic or dramatic effect. This can include distortions in facial features, 

body types, and expressions, but also the character’s movement. Exaggeration is a great way 

for an animator to increase the appeal of a character, and enhance the storytelling. 

https://idearocketanimation.com/8857-animation-techniques-smear/
https://vimeo.com/97356601


11) Solid Drawing 

Solid drawing is all about making sure that animated forms feel like they’re in three- 

dimensional space. 

 

 

This character design by Robert Kopecky for Proscenium is a good example of solid 

drawing. Kopecky is creating a character that will live through various iterations of history in the 

video. 

 

He starts by defining the volume of the character, which he describes in this character sheet 

at a teardrop/bowling pin. Then he adds different clothing, hair, and accessories to the 

character to take him to various parts of history. 

 

Notice how you can see the other side of the body shape on the inside of the mouth. But 

also, even when he is departing from three-dimensionality for graphic effect, as in the 

position of the eyes, he defines that in the character sheet too. 

12) Appeal 

People remember real, interesting, and engaging characters. Animated characters should be 

pleasing to look at and have a charismatic aspect to them; this even applies to the 

antagonists of the story. 

https://vimeo.com/24734687


 

Appeal can be hard to quantify because everyone has a different standard. That said, you can 

give your character a better chance of being appealing by making them attractive to look at. 

 

Play around with different shapes and proportions of characters to keep things fresh. 

Enlarging the most defining feature of a character can go a long way to giving the character 

personality. Strive for a good balance between detail and simplicity. 

 

Graphic, Button, and Movie Clip Symbols 

Most of the power of Flash comes from its ability to create and manipulate symbols. A symbol is 

a master object that resides in one place—a panel called the Library—but can generate multiple 

copies of itself that can be used anywhere in Flash. Symbols offer a variety of advantages, 

including: 

 Economy. If you have a visible object that’s intended to appear more than once in a 

Flash movie, you can convert it to a symbol. You can then place any number of instances 

(copies) of that symbol on the stage without any significant increase in the movie’s file 

size. 

 Adaptability. Whenever you make a change in a symbol, that change is instantly 

reflected in all instances of the symbol. 

 Flexibility. Every symbol has its own internal timeline. As a result, a symbol can contain 

its own animated content that plays independently of the animation in the main timeline. 

 Nestability. Symbols can be embedded in other symbols, which can be embedded in still 

other symbols. By nesting symbols in this way, you can animate complex movements 

easily—for example, you could embed a symbol of a propeller turning inside a symbol of 

an airplane flying. 

 Scriptability. Two kinds of symbols—buttons and movie clips—can be controlled using 

ActionScript. Movie clips can even include scripts of their own, allowing them to control 

other movie clips or the movie that contains them. 

This chapter shows you the basics of creating, modifying, and organizing symbols. More 

advanced use of symbols is covered in Chapter 5 (Creating Basic Animation) and Chapter 11 

(Introducing ActionScript). 

#22. Converting Objects to Symbols 

Any object (or group of objects) that can appear on the stage can be made into a symbol. Here’s 

how to do it: 

1. Select one or more objects on the stage. The selected objects may include paths, text 

objects, bitmaps, or even other symbols. 

2. Choose Modify > Convert to Symbol, or press the F8 key. The Convert to Symbol dialog 

box appears. 



(While this book usually doesn’t mention keyboard shortcuts, F8 is an exception because 

Convert to Symbol is such a frequently used command.) 

Naming Symbols 

Technically, Flash lets you assign to a symbol whatever name you like. In practice, 

however, there are two issues you may want to take into account when you name a 

symbol: 

o Convenience. Symbols listed in the library can be sorted by name or by type, 

but it’s much more convenient to have them sorted by name and by type 

without needing to switch between the two sorting modes. For this reason, 

many Flash developers like to give each symbol a prefix such as b_for button 

symbols, g_ for graphic symbols, and m_ for movie clip symbols. 

o Descriptiveness. The more precise your symbol names are, the easier it will 

be to find the one you want among dozens or hundreds of symbols. If your 

movie contains graphic symbols of a beagle, a poodle, and a schnauzer, don’t 

name the symbols g_dog1, g_dog2, and g_dog3. Instead, name them 

g_dogBeagle, g_dogPoodle, and g_dogSchnauzer. 

3. Enter a name for the symbol into the Name field. 

4. Click the radio button for the type of symbol you want to create: a movie clip, button, or 

graphic. (For the differences between these symbol types, see #27 and #28. If you’re 

experimenting with symbols for the first time, the simplest choice is Graphic.) 

5. Click one of the small squares in the diagram next to the word Registration. The square 

you click will determine the symbol’s registration point (Figure 22a). 

 

Figure 22a Click the square corresponding to your preferred location for the symbol’s 

registration point. Later, when you view the symbol in the library or in symbol-editing 

mode, your registration point will be indicated by crosshairs. 

Think of the registration point as the handle by which Flash will hold the symbol when 

it’s in motion (see #42). When you’re in doubt, the center is usually a good choice. 

Group or Symbol? 

Let’s say you have several objects on the stage that you want to make selectable with 

a single click. Should you group them, or convert them to a symbol? Here are some 

criteria to help you decide: 

o Impermanence. If you want just to bring the objects together temporarily, 

and you plan to separate them later, it’s quicker to use a group than a symbol. 
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o Uniqueness. If a set of objects will appear only once in the movie, it’s more 

efficient to group them than to convert them to a symbol. 

o Movement. If you plan to animate a set of objects, convert them to a symbol. 

(As you’ll see in #42, both symbols and groups can be motion-tweened, but 

motion-tweening symbols is preferable.) 

6. Click OK. 

You can find the symbol you just created in the library. (If the library isn’t part of your 

current workspace, choose Window > Library.) When you click the symbol’s name in the 

library list, you’ll see the symbol in the viewing pane above the list (Figure 22b). 

 

Figure 22b Each symbol is listed in the library next to an icon representing the symbol 

type. You can click the name of a symbol to see what it looks like. 

It’s also possible to create a symbol from scratch, without starting with an object on the 

stage. To do so, choose Insert > New Symbol. You’ll see a Create New Symbol dialog 

box, which is identical to the Convert to Symbol, except for the lack of a Registration 

diagram. 

When you complete the dialog box and click OK, Flash enters symbol-editing mode (see 

#24). If you wish, you can create some visual content for the symbol; if you’d rather wait 

until later, click Scene 1 in the breadcrumb trail to return to normal mode. If you don’t 

create any content for the symbol, it will still be listed in the library, but the viewing pane 

will be blank when you click the symbol’s name. 

Working with Symbols and Instances 

When you convert an object to a symbol, as you did in #22, the original object seems to remain 

on the stage. Although that object may look exactly as it did originally, it has become something 

quite different: It’s now an instance of the symbol in the library. 

An instance is a marker that points back to a symbol in the library and tells Flash, “display that 

symbol here.” That’s why multiple instances of a symbol don’t significantly affect file size: The 

symbol in the library contains all the information that defines it, and therefore takes up space in 

the file, but each instance contains barely any information other than a pointer to the symbol. 

NOTE 

Flash developers often refer to instances as symbols, as in “Let’s remove that symbol from the 

stage,” but that’s just shorthand. Strictly speaking, a symbol can be only in the library; any copy 

of it on the stage is an instance. 
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To create additional instances of a symbol, drag the symbol out of the library and onto the stage. 

The symbol itself stays in the library; what gets dragged is actually an instance of the symbol 

(Figure 23a). Another way to create additional instances is to duplicate an instance that’s 

already on the stage—by copying and pasting, for example. 

 

Figure 23a Every time you drag a copy of a symbol out of the library, you’ve created a new 

instance of that symbol. 

At first, all instances of a symbol look exactly the same as that symbol. It’s possible, however, to 

change the appearance of an instance in two ways (Figure 23b): 

 Transformation. By using the Free Transform tool, you can transform an instance in 

most of the same ways that you would a path: You can rotate it, scale it, or skew it (see 

#15). If an instance contains only vector paths, you can distort it as well. 

 Color effects. When you select an instance on the stage, a menu labeled Style appears in 

the Color Effect section of Properties. You can change the instance’s brightness, tint, or 

opacity by choosing the appropriate item from the menu (see #25). 

 

Figure 23b All of these objects are instances of the same symbol. The one at the upper 

left is unaltered; the others have all been transformed or have had color effects applied. 

When you alter an instance, you affect only that instance. The other instances and the symbol in 

the library remain unchanged. In contrast, when you edit a symbol, the changes you make are 

reflected in all instances of that symbol (see #24). 

Instance or Group? 

Symbol instances and groups behave similarly on the stage: Each allows you to select multiple 

objects with one click, as if they were a single object; each is surrounded by a blue rectangle 

when it’s selected; and each becomes editable when it’s double-clicked. If you’re not sure at first 

glance whether you’ve selected an instance or a group, there are two quick ways to tell: look for 

the registration crosshairs (an instance has them; a group doesn’t), or look at the Properties panel 

(it will say Group if a group is selected, or it will display the symbol type—Graphic, Button, or 

Movie Clip—if an instance is selected). 

Editing Symbols 
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There are two ways to edit a symbol. The first is to find the symbol in the library and double-

click either its name in the list or its image in the viewing pane. When you do so, everything on 

the stage disappears, and the symbol you’re editing becomes the only visible object. This is a 

good way to edit if you don’t want to be distracted, but it prevents you from seeing the symbol in 

context with the other items on the stage. 

The second way to edit a symbol, called editing in place, is to double-click any instance of a 

symbol on the stage. Flash goes into a symbol-editing mode that looks just like the group-editing 

mode described in #17: Everything other than the selected instance is dimmed, and the elements 

of the symbol become the only objects you can select and edit (Figure 24a). What’s unusual 

about editing in place is that when you double-click the instance, the master symbol temporarily 

takes its place. Any changes you make to the symbol will affect not only the instance you 

double-clicked, but all other instances as well. 

 

Figure 24a Flash is in editing-in-place mode for a graphic symbol called g_fish, which is inside a 

movie clip called m_fishbowl. The breadcrumb trail leads back to the original contents of the 

stage. 

While you’re in symbol-editing mode, using either editing method, you’ll see a small white 

circle with crosshairs. That circle represents the symbol’s registration point. The crosshairs can’t 

be moved, but if you want to change the symbol’s registration point, you can drag the contents of 

the symbol to a different position relative to the crosshairs. 

If you have symbols nested within symbols, you can drill down one level at a time by editing the 

outermost symbol, then double-clicking a symbol embedded in it, and so on. You can return to 

any earlier level by clicking the appropriate link in the breadcrumb trail (see #17). Clicking the 

leftmost link, called Scene 1 by default, takes you back to the main stage and exits symbol-

editing mode. 

Any changes you make to a symbol affect not only the symbol in the library, but all instances of 

that symbol, even if they were placed on the stage before you edited the symbol (Figure 24b). 
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Figure 24b Editing a symbol affects all instances of that symbol, even if they’ve been 

transformed or had color effects applied to them. (To see how these instances have changed, 

compare this screenshot to Figure 23b.) 

The Domino Effect 

When you make changes to a symbol, those changes affect all instances of the symbol. The 

effects may be especially far-reaching if some of those instances are embedded in other symbols. 

Say, for example, that an instance of Symbol A is embedded in Symbol B, and that an instance 

of Symbol B is embedded in Symbol C. If you make a change to Symbol A, the instances of all 

three symbols will reflect that change. 

 

Using Symbol Color Effects 

Let’s say you want to change the color of an individual instance of a symbol. You can’t use the 

Color panel to change its stroke or fill, because a symbol instance isn’t editable. You can’t 

double-click the instance and change its color in symbol-editing mode, because doing so would 

change the color of all instances of that symbol. 

The solution is to select the instance and look on the Properties panel for a section labeled Color 

Effect. Below that label is the Style menu, from which you can choose the type of effect you 

want to apply. Depending on which option you select, a different control (or set of controls) will 

appear next to the menu. The available options are: 

 Brightness. The brightness control is a slider ranging from –100% to 100%, with 0% as 

the default. Choosing a positive number brightens the instance; choosing a negative 

number darkens it. 

 Tint. There are several tint controls. The first, to the right of the Style menu, is a standard 

color menu that allows you to choose a tint for the instance in the same way you’d 

ordinarily choose a color for a stroke or fill (see #8). Farther down are three sliders—

labeled Red, Green, and Blue—that allow you to adjust the level of each primary color on 

a scale ranging from 0 to 255. 

None of these tint controls discriminates between strokes and fills. As a result, tinting an 

instance causes the stroke and fill to appear exactly the same color, even if they had 

contrasting colors to begin with. 

To avoid this problem, you can use the Tint slider. This control acts as if the tint were a 

separate object overlaying the instance: If the slider is set to 100%, only the tint is visible; 

if the slider is set to 0%, only the unchanged instance is visible. At intermediate 

settings—such as 50%, the default—the tint is treated as if it’s partly transparent, 

allowing some of the underlying instance to show through. As you lower the tint amount, 
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the original contrast between the stroke and fill colors becomes more apparent, but the 

tint looks increasingly washed out (Figure 25a). 

 

Figure 25a The effects of the Tint slider can be seen in these three different views of the 

same instance. On the left, the tint is set to 0%, leaving the original instance unchanged. 

In the center, the tint is set to 100%, completely covering the instance with a uniform 

color. On the right, the tint is set to 50%, allowing the instance to partially show through 

the tint. 

 Alpha. Alpha is synonymous with opacity. When the Alpha slider is set to 100% (the 

default), the instance is completely opaque; when it’s set to 0%, the instance is 

completely transparent (invisible). If the background behind the instance is white, the 

effect of lowering the alpha is indistinguishable from that of raising the brightness. 

 Advanced. This option lets you control tint and alpha at the same time. There are four 

controls—one each for Alpha, Red, Green, and Blue—with settings that align in columns 

(Figure 25b). By changing the values in the left column, you can vary the amount of 

alpha and of each primary color by percentage. (Note that a setting of 100% in this 

column indicates the level of alpha or color that’s already in the instance. For example, if 

the instance originally contains 30 percent blue, a setting of 100% would maintain that 

level of blue; a setting of 50% would bring it down to 15 percent blue.) 

 

Figure 25b The Advanced option allows you to change alpha and colors by percentages 

or by absolute amounts. 

By changing the values in the right column, you can add or subtract absolute amounts of 

alpha, red, green, and blue, in increments ranging from 255 to –255. Because these 

controls apply their calculations individually to each color in the instance, they preserve 

the differences between stroke and fill colors. Therefore, if you wish to apply a color 

effect to an instance, you’ll usually get better results with the Advanced option than you 

would with the Tint option. 

 

Creating Button Symbols 

A button is typically used in an interactive environment (such as a Web page) as a way for the 

user to make something happen. As interactive design has matured, users have developed 
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additional expectations. When they move the pointer over a button, they expect it to respond in 

some way—by getting brighter, for example. This change in a button’s appearance when a user 

rolls over it is known as a rollover effect. 

When users click a button, they expect some feedback showing that their input has been 

recognized. This feedback may take the form of an audible beep or click, an appearance change, 

or both. 

Flash has made it easy to create buttons that provide all of these responses. Here’s the usual 

procedure for making a functional button: 

1. Use the drawing tools to create the button’s normal appearance. 

2. Select the paths that constitute the button and choose Modify > Convert to Symbol, or 

press F8. The Convert to Symbol dialog box appears. 

3. Type a name for the symbol (preferably with a prefix such as b_) into the Name field. 

4. Below Type, choose Button. 

5. Click a square to choose the registration point. (For a button, the center position is 

typical.) 

6. Click OK. The button symbol appears in the library, and the button on the stage becomes 

an instance of the symbol. 

7. Enter symbol-editing mode, either by double-clicking the button symbol in the library or 

by double-clicking its instance on the stage. 

You’ll notice that the timeline changes from its standard layout to a series of four cells 

labeled Up, Over, Down, and Hit (Figure 27a). The labels Up, Over, and Down refer to 

three variations, or states, of the button. The Up state is the button’s appearance when the 

user isn’t interacting with it; the Over state is the way the button looks when the user rolls 

the pointer over it; and the Down state is the way the button looks when the user is 

clicking it (Figure 27b). 

 

Figure 27a This is how the timeline looks when a button symbol is being edited. 
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Figure 27b These examples show how a button might look in each of its three states. 

The black dot in the Up cell indicates that the symbol that’s currently on the stage will 

represent the Up state of the button. 

8. Click in the cell below the Over label. The cell darkens to indicate that it’s selected. 

Mystery Button 

You may have noticed that the buttons in Figures 27b and 27c don’t have any 

labels on them. It’s certainly possible to include text in a button symbol, thereby 

giving the button a label. Nevertheless, most Flash developers choose not to do so. 

If a button symbol contains text, the button can be used only for one purpose: the 

one expressed by its label. If there’s no text in a button symbol, the button can be 

used repeatedly for a variety of purposes simply by placing different text on top of 

each instance. 

 

Figure 27c A button’s Up state is on the left, and its Hit frame is shown in the 

center. The stroke and fill colors don’t matter for the Hit frame; all that matters is 

the shape of the filled path. That path determines the button’s clickable area, 

indicated by a dashed line on the right. 

9. Choose Insert > Timeline > Keyframe, or press F6. (To understand what’s happening in 

this step, see #30.) A black dot appears in the Over cell. Make sure this keyframe is 

highlighted (selected) for the next step. 

10. Change the button’s appearance to how you’d like it to look in its Over state. (The 

changes you make won’t affect the button’s appearance in the Up state.) 

11. Repeat Steps 8 through 10 in the next cell for the button’s Down state. You can ignore 

the Hit cell for now. 

12. Click Scene 1 in the breadcrumb trail above the stage. Flash exits symbol-editing mode. 

13. Choose Control > Enable Simple Buttons. (If the Enable Simple Buttons command 

already has a check mark next to it, skip this step.) 

14. Roll your pointer over the button instance on the stage. You’ll see it change to its Over 

state. 

15. Click the button instance on the stage. While your mouse button is depressed, you’ll see 

the button in its Down state. 

While those are the basic steps for making a multi-state button, there are other things you might 

want to do to enhance it. For example: 

 Add audio. You can add sounds as well as images to the Over and Down states. To find 

out how to attach an event sound to a keyframe, see #64. 
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 Add motion. A button doesn’t have to be static; any or all of its three states can be 

animated by means of embedded movie clips. To find out how to accomplish this, see 

#36. 

 Add a Hit frame. Some buttons are difficult for a user to click—for example, because 

they’re too small or irregularly shaped (Figure 27c). You can make the button more user 

friendly by giving it a larger or more uniform “hot zone.” To do so, return to editing the 

button, and repeat Steps 8 through 10 for the Hit cell. The variation of the button you use 

for the Hit frame won’t ever be seen on the stage, but it determines the size and shape of 

the clickable area around the button. 

Distinguishing Between Graphic Symbols and Movie Clips 

While button symbols are used for a single, specialized purpose, graphic symbols and movie 

clips have broader applications. Although graphic symbol sounds like something that contains a 

still image, and movie clip sounds like something that contains motion, the truth is that either 

type of symbol can have either type of content. The differences lie elsewhere. 

If you’re creating a symbol, and you don’t know whether to make it a graphic symbol or a movie 

clip, consider these issues: 

 Dependent or independent? Any instance of a graphic symbol is dependent on the pace 

of the movie it’s placed in. If the symbol contains animation that takes 52 frames to 

complete, then you’ll probably want the instance to remain on the stage for exactly 52 

frames. If the movie ends before those frames have elapsed, the action in the symbol will 

appear to be interrupted in the middle. 

In contrast, a movie clip runs independently of the movie it’s in. As long as a movie clip 

is on the stage, its animation will continue, even if the main movie ends (Figure 28a). 

For that matter, when the action in the movie clip reaches its end, it will start playing all 

over again from the beginning and loop repeatedly—unless you deliberately stop it with 

ActionScript. 

 

Figure 28a The rotation of this pinwheel is contained in a movie clip. Even after the 

animation of the child is over, the pinwheel will continue to turn. 

 Passive or interactive? ActionScript can’t control instances of graphic symbols—in fact, 

it doesn’t even recognize that they’re there. For that reason, graphic symbols are useful 
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mostly for traditional animation—the kind that the user watches, but doesn’t interact 

with. 

In contrast, a movie can use ActionScript to control the movie clip instances within it, 

and any of those instances can use ActionScript to control any of the others. (In fact, 

many interactive movies are only one frame long. The action of the movie takes place not 

in the timeline, but in sequential commands issued to movie clips by ActionScript.) 

The fact that a movie clip instance can be controlled by ActionScript doesn’t mean it has 

to be. It’s fine to have a movie clip that simply plays animation. However, in a situation 

in which a graphic symbol or a movie clip would serve equally well, it makes sense to go 

with the graphic symbol. Because of their more limited capabilities, graphic symbols take 

up less space in the SWF file and make fewer demands on the computer’s processor. 

Using the Library to Manage Symbols 

The library is more than a repository for symbols; it’s also a place where you can actively 

organize, modify, and track symbols. Many of the library’s features are hidden away—either 

represented by small, unlabeled icons, or listed on menus that are not immediately obvious 

(Figure 29a). 

 

Figure 29a Some of the Library panel’s less obvious controls are pointed out here. 
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Symboloids 

Although the library is often described as a place to store symbols, Flash stores some items in the 

library that are symbol-like but that don’t fit the usual definition of symbols. They include: 

 Font symbols. When Flash creates a SWF file, it automatically embeds font 

information for all the text characters that appear in the movie (see #19). But 

sometimes you’ll want to embed font information for characters that don’t appear in 

the movie, such as text that will be generated on the fly by ActionScript. To do so, 

you can right-click (Windows) or Control-click (Mac) anywhere in the library list, 

choose New Font from the context menu, and select a font from a list of all the fonts 

installed in your computer. The font then appears as an item in the library. 

 Components. Flash comes with a collection of components, or specialized objects 

that you can use to add interactivity to a movie (see Chapter 11). Components are 

initially stored in the Components panel, but once you drag a component into a 

movie, it appears in the library as well. A component is a symbol, but it can’t be 

edited or modified the way ordinary symbols can; you can alter its appearance and 

behavior only by means of ActionScript or the Component Inspector. 

 Multimedia assets. When you import sounds, video clips, and bitmap images into a 

FLA file, those assets are stored in the library. They behave somewhat like symbols, 

but you can’t modify multimedia assets inside Flash. 

Let’s look first at the four icons at the bottom of the Library panel. They are, from left to right: 

 New Symbol. Clicking this icon brings up the Create New Symbol dialog box (see #22). 

 New Folder. Just like the files on your computer’s hard drive, the items in the Flash 

library can be sorted into folders. Clicking the New Folder icon creates an empty folder 

into which you can drag any number of library items (including other folders). To expand 

a folder—that is, to see the folder’s contents—double-click the folder in the library list; 

to collapse the folder, double-click it again. 

 Properties. When you select any item in the library (other than a folder), clicking this 

icon opens a dialog box that lets you modify the item’s properties. The name and contents 

of the dialog box depend on what type of item you’ve selected. For example, if you’ve 

selected a symbol, the Symbol Properties dialog box appears; if you’ve selected a sound 

file, the Sound Properties dialog box appears. 

 Delete. You can delete any item in the library by selecting it and clicking the Delete icon 

or pressing the Delete key. Be careful, however: If you delete a symbol, all instances of 

that symbol will vanish from the movie. If you delete a folder, Flash will delete 

everything contained in the folder without giving you a warning or asking for 

confirmation. 

If more than one document is open, the panel displays the library contents of whichever 

document is in the foreground. To see the contents of another document’s library, you can select 

the document’s name from the pop-up menu above the viewing pane. 



The Pin icon to the right of that menu allows you to “pin” the current library in place—that is, to 

keep the current document’s contents visible in the Library panel even if you bring a different 

document to the foreground. Click the icon once to “pin” the library; click it again to “un-pin” it. 

The next icon to the right is the New Library Panel icon, which opens another copy of the current 

library in a separate panel. Doing this can be useful if you want to drag items between panels to 

copy them. 

Most of the library’s other features can be found in the Options menu, which you open by 

clicking the three-line icon on the upper right of the panel. You can get an almost identical 

contextual menu by right-clicking (Windows) or Control-clicking (Mac) anywhere in the Library 

panel. 

Some of the menu items, such as New Folder and Delete, are alternative ways to access features 

we’ve already looked at; others, such as Rename and Select Unused Items, are self-explanatory. 

Two menu items that need special explanation are those that deal with use counts. 

Among the features that become visible when you widen the Library panel is the Use Count 

column (Figure 29b). For each item in the library, the Use Count column tells you how many 

instances of that item have been used in the movie. By default, the numbers in this column are 

refreshed only when you right-click (Windows) or Control-click (Mac) the Library panel and 

choose Update Use Counts Now from the contextual menu. If you want the use counts to be 

updated automatically, you can choose Keep Use Counts Updated; however, this option can 

place a drag on the program’s performance. 

 

Figure 29b Widening the Library panel reveals previously unseen columns, including Use 

Count. 
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Basic factors affecting the illusion of motion 

What is an illusion? 

An illusion is defined as the phenomenon in which the properties of an object or image are 

different from how they appear, due to the way the brain processes information the eye receives. 

This is different from a hallucination, in which an individual sees or perceives something that is 

not actually present. In an illusion, the brain is fooled into seeing things differently than they 

actually are as it tries to make sense of the information it is receiving. There are thousands of 

examples of illusions in the natural world, from rainbows and mirages to camouflage. Illusions 

are often used in art, film, and photography. 

Types of Illusions 

There are many different types of illusions. The three main types are visual or optical, auditory, 

and tactile, but other types exist. They can appear naturally or be created. 

Visual Illusions 

Visual illusions can happen for several reasons. The eye is an organ that detects light and objects 

and sends signals to the brain about what it sees. One kind of visual illusion is actually a 

cognitive illusion that happens when the eye perceives an image and the brain fills in missing 

information, causing the individual to perceive something different from the object or picture 

that is actually there. This is the type of illusion used in photos where individuals are shown a 

picture and asked what they see first, and different people see two different images. One of the 

most well-known examples is William Ely Hill's "My Wife and Mother-in-law," in which 

individuals are asked to look at the picture and tell whether they see a young woman looking 

away or an old woman looking down. It is not the eye itself, but rather their perception that will 

determine the answer. This is also the reason people may see animal shapes in clouds or a face 

on a rock. 



 

     

 

 

The brain may also perceive motion where it does not exist, due to its need for closure, which is 

the phenomenon behind the Ternus Effect, sometimes referred to as the Ternus-Pikler effect. In 

this illusion, three discs are presented in a row. In a series of frames, the discs are simply shifted 

one position to the right or left. The center disc remains in the center. This causes the perception 

that the discs are moving. Some see it as though all the discs are moving together as a group, 

while others may perceive that the first disc is jumping across the other two discs, while they 

remain in the same place. 



 

 

 

 

Another optical illusion happens when the brain misinterprets the size of an object because of the 

surrounding stimuli. One example is Ebbinghaus' Tichtener Circles. In the illustration, the orange 

circles appear to be different sizes when they are actually the same. This is because the brain 

takes in information about the surrounding gray circles and interprets the size of the orange 

circles based on that context. 

 

 



 

 

One type of optical illusion is caused by the way light interacts with matter. As light passes 

through different types of matter in different ways, it may cause the eye to perceive a distortion 

that isn't actually there. This is why objects appear differently underwater. Light passing from air 

to water changes direction and becomes refracted. This changes the way the object appears, even 

though the changes are not real. This refraction can also cause the eye to see light or color 

differently, which is why the presence of rain can cause the eye to see a rainbow. 

 

 

Auditory Illusions 

The brain's need for closure can also cause misperceptions or misunderstandings about what the 

ear hears. This is an auditory illusion. For example, when people hear an audio track in which 

one consonant has been removed and replaced with a non-speech sound, they will still be able to 

understand the message because of the phoneme restoration effect. Similarly, the Ganong effect 

occurs when a person hears a fake word or ambiguous speech sound and hears it as a real, 

complete word. The brain is able to predict, based on lexical knowledge, what is going to be 

said. It fills in the information based on what it believes it is hearing. 



The Doppler effect occurs when an increase or decrease in the frequency of a sound changes as 

the observer and the object creating it move closer or further apart. This is the phenomenon 

responsible for the fact that an individual will perceive a change in the pitch of a siren as a fire 

truck passes by. The source is moving, which causes changes in the waves of the sound. As the 

object gets closer, the sound waves become more compressed and are perceived in a higher 

pitch. 

Tactile Illusions 

Tactile illusions occur when the characteristics of an object or touch are misinterpreted by the 

brain. Sometimes this perception can be influenced by visual perception, as the visual perception 

will typically be dominant. Tactile illusions can involve passive or active touch. For example, 

taps on the arm may be perceived to be closer together spatially when the speed of the taps is at 

closer intervals. This is known as the Tau Effect. Likewise, the Kappa Effect happens when taps 

are perceived to be farther apart spatially when they are at further intervals. This is attributed to 

the fact that the brain uses its understanding of the natural world to supply information about the 

context. Essentially, it expects slowly moving objects to occur more often than rapidly moving 

ones. 

  

Impact of digital techniques on the craft of film and video animation 

Technology has been transforming various industries ranging from healthcare, eCommerce, 

retail, media, education, and manufacturing to all industry niches imaginable. 

Similarly, technology has brought a paradigm shift in the film industry as well. From the way the 

film is shot to post-production and editing to distribution and marketing, the technology is 

providing a much-needed edge to the film industry. 

The use of technology has improved the qualitative aspects of moviemaking, as advanced 

technologies ensure engaging and crisp visuals, enhanced sound effects, easier editing tools, and 

digital film distribution, which helps offer an enriched movie experience to the viewers. 

From the viewer’s perspective, technological change is very much visible. Moviegoers can avail 

the of innovative screening interfaces like 3D spectacles, VR headgears, IMAX, 7D, and many 

more. 

Viewers can watch movies on OTT platforms such as Amazon Prime, Netflix, YouTube, and 

several others. The movie-making business is now multifaceted, and technology has only 

simplified it and expanded the scope of filmmaking, film watching, and other business activities. 



Film making is an exhausting process, that demands collaborated efforts of too many skilled 

professionals, artists, and technicians. 

It also involves huge development costs and other technical aspects including IP (intellectual 

property) rights. With the evolution of digital technology, we have seen transformational changes 

in almost every aspect of filmmaking. 

Film Shooting 

Digital cameras have changed the filmmaking process. With the help of large format sensor 

cameras and lenses, we can easily shoot movies with a high frame rate in extra sharp 4K, 8K, or 

HD format. 

Photographers can experiment using multiple angle cameras and a variety of controls to obtain 

the required colour scheme, light scheme, saturation, etc. A digital camera also allows 

photographers to shoot in real-time and rectify any mistakes immediately. 

Production Cost 

Technology has indeed helped filmmakers to reduce the overall cost of filmmaking. Filmmakers 

can shoot, edit, preserve and store the digital copies of their movies, which costs quite less if we 

compare with the raw material films. 

The use of digital cameras and other technologies helps produce a movie in lesser time than 

conventional film cameras. The digital format also enables filmmakers to complete their 

schedules in less time with almost negligible waste, thus keeping the project cost under control. 

Editing 

Editing comes in the post-production stage, where Digital technology helps the editors to work 

on multiple sections and piece them together to make a clean movie. 

We have numerous film-editing software, where editors can easily combine the film clips, sound 

clips, special effects, CGI, and various other treatments to the raw file. 

With the use of digital technology, the editor can make an unlimited number of errors and fix 

them to fetch a much cleaner output. 

Preservation 

The preservation of conventional films used to be very cumbersome and expensive, along with 

many logistical challenges. 

Digital movies have mitigated all such concerns as now we need a few gigabytes of storage 

space instead of large physical storage of the film. 

Digital copies of movies can be stored on servers at a fractional cost of storing the physical films. 



Film Distribution 

Digital technology has enabled filmmakers to distribute their movies to a larger audience with 

almost no additional cost. 

Filmmakers can distribute their movies on OTT platforms to tap the audiences beyond the 

traditional theatres and multiplexes. 

The movie rights can be distributed to the consumers digitally, which opens the exhilarating new 

world of film distribution. 

The film making has been revolutionised with the usage of state-of-the-art technologies. We can 

see how advanced gadgets, innovative audiovisual techniques, hardware, and applications have 

been used to deliver enthralling visuals with ease. 

3D and 4K-8K Technology 

3D effects coupled with 4K technology have transformed the experience of sci-fi movies and 

action dramas. 

Filmmakers can use Lucid camera, VR technology, and high-definition formats to shoot 

3Dimensional videos with 4k or 8K resolution. 

This technology helps filmmakers to shoot underwater scenes, multiple angles, and high-octane 

action scenes to deliver an immersive experience to the viewers. 

Drones 

Gone are the days when low-flying aircraft or helicopters were used to shoot panoramic or bird’s 

eye-view scenes. However, those shots used to come at a high cost along with stabilisation 

issues. 

The drones came as a very useful and handy technology, that enable the filmmakers to obtain 

such shots with fewer complications and at a very less cost. 

Drones could be used to shoot high-fidelity action scenes with finesse, and that’s why drones 

have become the preferred alternative to aircraft and helicopters. 

Multi-Dimensional Movie Technology 

You may remember how we used to watch 3D movies in the early ’90s using paper-made 3D 

glasses. 

Since then, we have seen an incremental change in multi-dimensional movie technology. We 

have reached a stage where the 3D viewing experience is viable without any external gadget or 

spectacle. 

Now we have moved to 7D or 8D movies, where viewers can experience computer- controlled 

swing, shake, fall, rise, spray water, air, and other special effects. Multi-dimensional 



technologies let the audience enjoy the visual, auditory, dynamic, and tactile aspects of the 

movie. 

Dual Camera Virtual Reality 

Dual Camera VR is an innovative film shooting technology, that brings the real world into the 

VR realm. 

In this technology, one camera shoots the movie characters, while another one can shoot the 

surroundings and environment. When we integrate both visuals with Virtual Reality, it gives an 

immersive 360-degree viewing experience to the viewer. 

AI aided smart screenplay writing 

Well, we have discussed the role of technology in filmmaking which offers a brilliant 

audiovisual experience to the viewers. 

But, do you know that technology could be used to write screenplays and dialogues as well? We 

do have a couple of AI software that can write screenplays, dialogues, or even songs for you. A 

New York-based research institution has developed an AI-powered robot called Benjamin, which 

has been trained with thousands of songs, and it can write a full-fledged song without any 

external assistance. 

Prevailing file format standards and other compatibility issues 

Abbreviation 
File 

format 

MIME 

type 

File 

extension(s) 
Summary 

APNG  

Animated 

Portable 

Network 

Graphics 

image/apng .apng 

Good choice for lossless animation sequences 

(GIF is less performant). AVIF and WebP 

have better performance but less broad 

browser support. 

Supported: Chrome, Edge, Firefox, Opera, 

Safari. 

AVIF  

AV1 

Image File 

Format 

image/avif .avif 

Good choice for both images and animated 

images due to high performance and royalty 

free image format. It offers much better 

compression than PNG or JPEG with support 

for higher color depths, animated frames, 

transparency, etc. Note that when using 

AVIF, you should include fallbacks to 

formats with better browser support (i.e. using 

the <picture> element). 

Supported: Chrome, Firefox (still images 

only: animated images not implemented), 

Opera, Safari. 

https://developer.mozilla.org/en-US/docs/Web/Media/Formats/Image_types#apng_animated_portable_network_graphics
https://developer.mozilla.org/en-US/docs/Web/Media/Formats/Image_types#avif_image
https://developer.mozilla.org/en-US/docs/Web/HTML/Element/picture


Abbreviation 
File 

format 

MIME 

type 

File 

extension(s) 
Summary 

APNG 

Animated 

Portable Network 

Graphics 

image/apng .apng 

Good choice for lossless animation sequences (GIF is 

less performant). AVIF and WebP have better 

performance but less broad browser support. 

Supported: Chrome, Edge, Firefox, Opera, Safari. 
 

image/apng .apng 
 

.apng 

Good choice for lossless animation sequences (GIF 

is less performant). AVIF and WebP have better 

performance but less broad browser support. 

Supported: Chrome, Edge, Firefox, Opera, Safari. 

JPEG  

Joint 

Photograp

hic Expert 

Group 

image 

image/jpeg 

.jpg, .jpeg, .j

fif, .pjpeg, .

pjp 

Good choice for lossy compression of still 

images (currently the most popular). Prefer 

PNG when more precise reproduction of the 

image is required, or WebP/AVIF if both 

better reproduction and higher compression 

are required. 

Support: Chrome, Edge, Firefox, IE, Opera, 

Safari. 

PNG  

Portable 

Network 

Graphics 

image/png .png 

PNG is preferred over JPEG for more precise 

reproduction of source images, or when 

transparency is needed. WebP/AVIF provide 

even better compression and reproduction, but 

browser support is more limited. 

Support: Chrome, Edge, Firefox, IE, Opera, 

Safari. 

SVG 

Scalable 

Vector 

Graphics 

image/svg+

xml 
.svg 

Vector image format; ideal for user interface 

elements, icons, diagrams, etc., that must be 

drawn accurately at different sizes. 

Support: Chrome, Edge, Firefox, IE, Opera, 

Safari. 

WebP  

Web 

Picture 

format 

image/web

p 
.webp 

Excellent choice for both images and 

animated images. WebP offers much better 

compression than PNG or JPEG with support 

for higher color depths, animated frames, 

transparency etc. AVIF offers slightly better 

compression, but is not quite as well-

supported in browsers and does not support 

progressive rendering. 

Support: Chrome, Edge, Firefox, Opera, 

Safari 

Note: The older formats like PNG, JPEG, GIF have poor performance compared to newer 

formats like WebP and AVIF, but enjoy broader "historical" browser support. The newer image 

formats are seeing increasing popularity as browsers without support become increasingly 

irrelevant (i.e. have virtually zero market share). 

The following list includes image formats that appear on the web, but which should be avoided 

for web content (generally this is because either they do not have wide browser support, or 

because there are better alternatives). 

https://developer.mozilla.org/en-US/docs/Web/Media/Formats/Image_types#apng_animated_portable_network_graphics
https://developer.mozilla.org/en-US/docs/Web/Media/Formats/Image_types#jpeg_joint_photographic_experts_group_image
https://developer.mozilla.org/en-US/docs/Web/Media/Formats/Image_types#png_portable_network_graphics
https://developer.mozilla.org/en-US/docs/Web/Media/Formats/Image_types#svg_scalable_vector_graphics
https://developer.mozilla.org/en-US/docs/Web/Media/Formats/Image_types#webp_image


Abbreviation File format 
MIME 

type 

File 

extension(s) 
Description 

BMP Bitmap file image/bmp .bmp 
Chrome, Edge, Firefox, IE, 

Opera, Safari 

ICO Microsoft Icon 
image/x-

icon 
.ico, .cur 

Chrome, Edge, Firefox, IE, 

Opera, Safari 

TIFF  

Tagged Image File 

Format 
image/tiff .tif, .tiff Safari 

 

 

History of Animation 

Thaumatrope:  A thaumatrope (invented by Paul Roget in 1828) is a simple mechanical toy which 

creates the illusion of movement. Thaumatrope means “wonder turner” derived from the Greek words: 

θαῦμα “wonder” and τρόπος “turn”. Roget was the first person in history to create such a device which 

produces the illusion of movement. In order to enjoy this animation, one would only need one small 

round piece of paper with pictures on it and thin ropes fixed at both ends of the shape (Figure 1). Below 

shows what a thaumatrope (Figure 1) is and how the illusion of movement is produced (Figure 2). 

 

https://developer.mozilla.org/en-US/docs/Web/Media/Formats/Image_types#bmp_bitmap_file
https://developer.mozilla.org/en-US/docs/Web/Media/Formats/Image_types#ico_microsoft_windows_icon
https://developer.mozilla.org/en-US/docs/Web/Media/Formats/Image_types#tiff_tagged_image_file_format


 

Phenakistoscope:  After the invention of the thaumatrope, the phenakistoscope followed made possible 

by J.A. Ferdinand Plateau in 1832. This device uses the persistence of vision principle to create an 

illusion of movement. Phenakistoscope originated from the Greek φενακίζειν (phenakizein), meaning 

"to trick or cheat"; as it tricks the eye by making the figures in the pictures appear to move. It is 

composed of six similar images in different positions taken in order to relay the movement. A very 

simple example is a running reindeer and jumping frogs (Figure 3). 

 

Zoetrope:  In 1843, William Horner, a British mathematician invented the zoetrope. A zoetrope 

produces an illusion of movement from a rapid succession of static pictures. Derived from the Greek 

words ζωήzoe, "life" and τρόπος tropos, "turn" this forms a “wheel of life”. 

 

 



Praxinoscope : Almost the same as a zoetrope, the only difference was the integration of a mirror to the 

device which makes the viewer more comfortable as they watch the movement of the objects. It was 

designed by Emile Reynaud in 1877 and was known as the “action viewer”. 

 

Kinestoscope: Figure 5. Praxinoscope in black and white, and a version in colour. 7 An early motion 

picture exhibition device was invented in 1888 by Thomas Edison together with his colleague Eadweard 

Muybridge. The kinestoscope was designed for films to be viewed through the window of a cabinet 

(Figure 6). Kinestoscope means the “view of movement”  

 

 

Multiplane Camera and Storyboard Walt Disney and his colleagues had a problem with creating realistic 

animation and how to conserve time while creating it. Then they came up with a great solution which 

can be considered another innovation in the field of animation - the multiplane camera (Figure 12). The 

multiplane camera is a piece of equipment designed to make cartoons more realistic and enjoyable. It 

uses stacked panes of glass each with different elements of the animation (Figure 13). With this, it 

allowed for the reuse of backgrounds, foregrounds, or any elements not in motion. The multiplane 



camera was developed by a Walt Disney Productions team headed by William Garity in the early 1930s. 

It was also known as the “super cartoon camera”. The storyboard was yet another successful creation in 

animation technology. It is used to recheck the story and utilizes pencil sketches to review motion. 

 

 

Next we will discuss the first ever animated films together with some of the most famous and successful 

animation characters. Outstanding works in stop motion and clay motion are also elucidated, followed 

by a discussion of computer graphics and computer animation, i.e., 3D animation.  Humorous Phases of 

Funny Faces After the invention of the above-mentioned devices, J. Stuart Blackton made the first 

animated film in 1906. The film was entitled Humorous Phases of Funny Faces, and with this he became 

known as the father of animation. He was using a blackboard as his workplace together with chalk and 

an eraser as his main tools. He was able to record the animation using the “draw-stop-film-erase” 

method.   

 

The Birth of Cartoon Characters The creation of the first ever animated film also inspired many 

animators to create their own animations. For instance, Winsor McCay drew Gertie, the trained 

dinosaur (Figure 8). It was an animated film astonishingly consisting of 10,000 drawings. The animation 

was shown as a film in theatres as well as at a multimedia event on stage with McCay interacting with 

the animated Gertie. Next in line was Felix the Cat (Figure 9). During the early 1920s, he became the 

most famous animated character. Then who could forget Mickey Mouse? (Figure 10). Mickey Mouse 

was created on November 18, 1928 and with his creation came the first successful sound animated film. 

Mickey Mouse was originally known as Steamboat Willie (Figure 11). He became an international star 



and made way for the launch of Disney Studios. Lastly, Looney Tunes was introduced in 1930 by Hugh 

Harman and Rudolp Ising run by the Warner Bros. Company. Bugs Bunny, Daffy Duck, Tweety Bird and 

Silvester are just a few of the main characters in this cartoon. 

 

 

 

Stop Motion and Claymation Stop motion animation is used to animate things that are smaller than life 

size. Willis Harold O’Brian pioneered motion picture special effects, which were perfected in stop 

motion. He became famous after his successful work on King Kong (Figure 14), claiming the title Dean of 

Stop-action Animation. Ray Harryhausen followed in the footsteps of O’Brian and became one of the 

most outstanding stop motion film makers through his films Mighty Joe Young and The Lost World 

(Figure 15). On the other hand, claymation also became a trend. Technically, it is the art of moulding 

clay figures and making them move, dance, talk, sing and whatever you can think of. Frames 10 are run 

together to produce the animation. Chicken Run and Wallace & Grommit are the two most successful 

claymations created by Aarmand Studios of the United Kingdom 

 

Basic geometric transformations 

Computer Graphics provide the facility of viewing object from different angles. The architect can study 

building from different angles i.e. 



1. Front Evaluation 

2. Side elevation 

3. Top plan 

A Cartographer can change the size of charts and topographical maps. So if graphics images are coded as 

numbers, the numbers can be stored in memory. These numbers are modified by mathematical 

operations called as Transformation. 

The purpose of using computers for drawing is to provide facility to user to view the object from different 

angles, enlarging or reducing the scale or shape of object called as Transformation. 

Two essential aspects of transformation are given below: 

1. Each transformation is a single entity. It can be denoted by a unique name or symbol. 

2. It is possible to combine two transformations, after connecting a single transformation is 

obtained, e.g., A is a transformation for translation. The B transformation performs scaling. The 

combination of two is C=AB. So C is obtained by concatenation property. 

There are two complementary points of view for describing object transformation. 

1. Geometric Transformation: The object itself is transformed relative to the coordinate system or 

background. The mathematical statement of this viewpoint is defined by geometric 

transformations applied to each point of the object. 

2. Coordinate Transformation: The object is held stationary while the coordinate system is 

transformed relative to the object. This effect is attained through the application of coordinate 

transformations. 

An example that helps to distinguish these two viewpoints: 

The movement of an automobile against a scenic background we can simulate this by 

o Moving the automobile while keeping the background fixed-(Geometric Transformation) 

o We can keep the car fixed while moving the background scenery- (Coordinate Transformation) 

Types of Transformations: 

1. Translation 

2. Scaling 

3. Rotating 

4. Reflection 

5. Shearing 

https://www.javatpoint.com/computer-graphics-translation
https://www.javatpoint.com/computer-graphics-scaling
https://www.javatpoint.com/computer-graphics-rotation
https://www.javatpoint.com/computer-graphics-reflection
https://www.javatpoint.com/computer-graphics-shearing


Note: Translation, Scaling, and Rotation are also called as Basic Transformations. 

 

Boolean operation On shape 

 

The Boolean sketch feature tool allows you to combine, subtract, or intersect parts or 

surfaces. Parts must intersect for Boolean to work. It will not work with two self-contained 

parts. Here we have three cylindrical parts. Select the Boolean feature tool from the sketch 

toolbar. 

Types of Boolean Operations 

Boolean operations combine any set of shape layers through one of four formulas: Union, 

Subtract, Intersect, and Exclude.  

Boolean groups are treated as a single shape layer and share fill and stroke properties and can be 

combined with other boolean groups through subsequent boolean operations. 

 Union: Union combines the selected shapes into a boolean group. If the objects overlap, the 

new shape’s outer path consists of the composite of its sublayers’ paths minus any segments 

that overlap. The stroke would then be applied to that outer path ignoring any path segments 

which overlap each other. 

 Subtract: Subtract is the opposite of Union. Subtract removes the area of a shape or set of 

shapes from a base shape. Only the bottom shape layer is solid, the rest are subtracted from it. 

 Intersect: Intersect creates a boolean group whose shape consists only of the overlapping parts 

of its sublayers. 

 Exclude: Exclude is the opposite of Intersect. Exclude shows only the areas of its sublayers 

that do not overlap. 

Animate Attributes 

 When you select this option, the following dialog box appears: 

  

 The pop-up menu offers a range of attributes that can be applied to an animated object. 

Each attribute that is selected is an action within a step. The action is implemented in the 

active sequence as a new step in line with the current time (the position of the timeline). 



  

 If the timeline is positioned at an existing step, the action is added on to this step. In this 

case, the attribute is animated. In other words, an area is gradually filled with a color 

throughout the duration of the step, for example. 

 If the timeline is outside the existing sequences, the action sets a new step as part of a 

new sequence. 

 Clicking OK confirms and adopts the attribute setting. Clicking Cancel returns you to 

the Edit Animation dialog box without any changes being adopted. 

 Visibility 

 In principle, an animated object is visible. If this attribute is implemented as an action 

when the Visibility box is unchecked, the object in question becomes invisible from the 

point during playback when the attribute was set. The invisible attribute continues to 

apply until a new action is generated with the attribute for visibility. If the box next 

to Visibility is checked, visibility has been selected. 

  

 While editing in Arbortext IsoDraw , the contour lines and the colors of filled areas that 

belong to invisible objects are depicted in the selected grid color. 

  

Any elements on the drawing sheet that have been hidden using the Hide command in 

the Element menu are also depicted in the selected grid color. 

 Interactivity 

 If a link exists for the animated object, this attribute can be used to switch the link on and 

off. 

 In principle, interactivity is applied to an animated object. If this attribute is implemented 

as an action when the Interactivity box is unchecked, interactivity for the object in 



question is switched off from the point during playback when the attribute was set. This 

attribute continues to apply until a new action is generated with the attribute for 

interactivity. If the box next to Interactivity is checked, the attribute will switch 

interactivity back on. 

  
 Stroke Width 

 This option involves converting the selected object’s original contour line widths to a 

new value. Enter the value for the width of the contour lines next to Value in the dialog 

box. The width of all the lines are converted to the value entered here. If you click the 

box next to as percentage, the setting next to Value changes from mm to %. The 

numerical value entered indicates the percentage change of each original line width. 

  
 Stroke Color 

 This option involves converting the original color(s) of the object’s contour lines to one 

new color. Click on the color field in the dialog box. Select the color from the 

subsequent Color dialog box. If no color is selected, the original color(s) are retained. If 

you click the box next to as percentage, you can specify the color’s tone. Enter the 

percentage value in the entry field next to the color field. 

  
 Fill Color 



 This option involves converting the original color(s) of the object’s filled areas to one 

new color. Click on the color field in the dialog box. Select the color from the 

subsequent Color dialog box. If no color is selected, the original color(s) are retained. If 

you click the box next to as percentage, you can specify the color’s tone. Enter the 

percentage value in the entry field next to the color field. 

  
 Text Color 

 This option involves converting the original color(s) of the object’s text elements to one 

new color. Click on the color field in the dialog box. Select the color from the 

subsequent Color dialog box. If no color is selected, the original color(s) are retained. If 

you click the box next to as percentage, you can specify the color’s tone. Enter the 

percentage value in the entry field next to the color field. 

  
 Font Size 

 This option involves converting the selected object’s original font sizes to a new value. 

Enter the value for the font size next to Value in the dialog box. The font sizes of all the 

text elements are converted to the value entered here. If you click the box next to as 

percentage, the setting next to Value changes from pt to %. The numerical value that is 

entered will then set the percentage change of the original font size(s) of the text elements 

in the object. 



  
 Raster Intensity 

 In the case of objects with raster data, this option can be used to reduce intensity. Enter 

the degree to which intensity is to be reduced as a percentage in the entry field next 

to Value. Intensity is reduced in line with the percentage entered. Entries exceeding 100 

(%) are not adopted. 

  

 

Create or edit a gradient fill 
A gradient is a multicolor fill in which one color gradually changes into another color. Animate (formerly 

Flash Professional CC) lets you apply up to 15 color transitions to a gradient. Creating a gradient is a good 

way to create a smooth color gradation across one or more objects. You can save a gradient as a swatch 

to make it easy to apply the gradient to multiple objects. Animate can create two types of gradients: 

Linear gradients change color along a single axis (horizontal or vertical). 

Radial gradients change color in an outward direction starting from a central focal point. You can adjust 

the direction of a gradient, its colors, the location of the focal point, and many other properties of the 

gradient. 

Animate provides additional control over linear and radial gradients for use with Flash Player. These 

controls, called overflow modes, let you specify how colors are applied beyond the gradient. 

1. To apply a gradient fill to existing artwork, select an object or objects on the Stage. 

2. If the Color panel is not visible, select Window > Color. 

3. To select a color display mode, select RGB (the default setting) or HSB from the panel menu. 

4. Select a gradient type from the Type menu: 

  



Linear 

Creates a gradient that shades from the starting point to the end point in a straight line. 

  

Radial 

Produces a gradient that blends outward in a circular path from a central focal point. 

 When you select a linear or radial gradient, the Color panel also includes two other options if 

you are publishing for Flash Player 8 or later. First, the Overflow menu is enabled below the Type 

menu. Use the Overflow menu to control the colors applied past the limits of the gradient. Second, 

the gradient definition bar appears, with pointers below the bar indicating the colors in the gradient. 

5. (Optional) From the Overflow menu, select an overflow mode to apply to the gradient: Extend 

(the default mode), Reflect, or Repeat. 

6. (Optional) To create an SVG-compliant (Scalable Vector Graphics) linear or radial gradient, select 

the Linear RGB check box. This will allow the gradient to look smooth when scaled to different 

sizes after it is first applied. 

7. To change a color in the gradient, select one of the color pointers below the gradient definition 

bar (the triangle at the top of the selected color pointer will turn black). Then click in the color 

space pane that appears above the gradient bar. Drag the Brightness slider to adjust the lightness 

of the color. 

8. To add a pointer to the gradient, click on or below the gradient definition bar. Select a color for 

the new pointer, as described in the previous step. 

You can add up to 15 color pointers, letting you create a gradient with up to 15 color transitions. 

9. To reposition a pointer on the gradient, drag the pointer along the gradient definition bar. Drag a 

pointer down and off of the gradient definition bar to remove it. 

10. To save the gradient, click the triangle in the upper-right corner of the Color panel, and select 

Add Swatch from the menu. 

The gradient is added to the Swatches panel for the current document. 

11. To transform the gradient, such as to make a vertical gradient instead of a horizontal one, use the 

Gradient Transform tool. See Transform gradient and bitmap fills for more information. 

Adjust Stroke and Fill color 

You can specify the stroke and fill color of graphic objects and shapes using either the Stroke Color and 

Fill Color controls in the Tools panel, or the Stroke Color and Fill Color controls in the Property inspector. 

The Stroke Color and Fill Color section of the Tools panel contains controls for activating the Stroke Color 

and Fill Color boxes, which in turn determine whether the strokes or fills of selected objects are affected 

by color choices. Also, the Colors section has controls for quickly resetting colors to the default, setting 

the stroke and fill color settings to None, and swapping fill and stroke colors. 

https://helpx.adobe.com/in/animate/using/strokes-fills-gradients.html#transform_gradient_and_bitmap_fills


In addition to letting you select a stroke and fill color for a graphic object or shape, the Property inspector 

provides controls for specifying the stroke width and style. 

To use these controls to change the painting attributes of existing objects, first select the objects on the 

Stage. 

Also see: Live Preview of Colors. 

Adjust stroke and fill color using the Tools panel 

The Tools panel Stroke Color and Fill Color controls set the painting attributes of new objects you create 

with the drawing and painting tools. To use these controls to change the painting attributes of existing 

objects, first select the objects on the Stage. 

 Click the Stroke or Fill Color control, and select a color swatch. 

 Click the System Color Picker button in the pop-up window, and select a color. You could also hover the 

pointer over different colors to preview the effect of the color on the shape. 

 Type a color’s hexadecimal value in the box. 

 To return to the default color settings (white fill and black stroke), click the Black And White button in the 

Tools panel. 

 To remove any stroke or fill, click the No Color button. 

 The No Color button appears only when you are creating an oval or rectangle. You can create an 

object without a stroke or fill, but you cannot use the No Color button with an existing object. Instead, select 

the existing stroke or fill and delete it. 

 To Swap colors between the fill and the stroke, click the Swap Colors button in the Tools panel. 

Animate allows you to preview Stroke or Fill colors live when changing them from the Color Swatch. For 

more information, see Live Preview of Colors. 

Apply a solid color fill using the Property inspector 

1. Select a closed object or objects on the Stage. 

2. Select Window > Properties. 

3. To select a color, click the Fill Color control and do one of the following: 

  

 Select a color swatch from the palette. 

  

 Type a color’s hexadecimal value in the box. 

Select a stroke color, style, and weight using the Property 

inspector 

To change the stroke color, style, and weight for a selected object, use the Stroke Color control in the 

Property inspector. For stroke style, choose from styles that are preloaded with Animate, or create a 

custom style. To select a solid color fill, use the Fill Color control in the Property inspector. 

https://helpx.adobe.com/in/animate/using/draw-simple-lines-shapes.html#main-pars_header
https://helpx.adobe.com/in/animate/using/draw-simple-lines-shapes.html#main-pars_header


1. Select an object or objects on the Stage (for symbols, first double-click to enter symbol-editing 

mode). 

2. Select Window > Properties. 

3. To select a stroke style, click the Style menu and select an option. To create a custom style, click 

Custom in the Property inspector, select options in the Stroke Style dialog box, and click OK. 

  

 Selecting a stroke style other than Solid can increase file size. 

4. To select a stroke weight, set the Stroke slider or enter a value in the text box. 

5. To enable stroke hinting, select the Stroke Hinting check box. Stroke hinting adjusts line and 

curve anchors on full pixels, preventing blurry vertical or horizontal lines. 

6. To set the style for a path end, select a Cap option: 

  

None 

Is flush with the path’s end. 

  

Round 

Adds a round cap that extends beyond the path end by half the stroke width. 

  

Square 

Adds a square cap that extends beyond the path by half the stroke width. 

7. (Optional) If you are drawing lines using the Pencil or Brush tools with the drawing mode set to 

Smooth, use the Smoothing slider to specify the degree to which Animate smooths the lines you 

draw. 

  

By default, the Smoothing value is set to 50, but you can specify a value from 0 to 100. The 

greater the smoothing value, the smoother the resulting line. 

  

 When the drawing mode is set to Straighten or Ink, the Smoothing slider is disabled. 

8. To define how two path segments meet, select a Join option. To change the corners in an open or 

closed path, select a path and select another join option. 

 



Miter, round, and bevel joins. 

9. To avoid beveling a Miter join, enter a Miter limit. 

  

Line lengths exceeding this value are squared instead of pointed. For example, a Miter limit of 2 

for a 3-point stroke means that when the length of the point is twice the stroke weight, Animate 

removes the limit point. 

 

Applying a Miter limit. 

Adjust the strokes of multiple lines or shapes 

To change the stroke color, width, and style of one or more lines or shape outlines, use the Ink Bottle tool. 

You can apply only solid colors, not gradients or bitmaps, to lines or shape outlines. 

Using the Ink Bottle tool, rather than selecting individual lines, makes it easier to change the stroke 

attributes of multiple objects at one time. 

1. Select the Ink Bottle tool from the Tools panel. 

2. Select a stroke color. 

3. Select a stroke style and stroke width from the Property inspector. 

4. To apply the stroke modifications, click an object on the Stage. 

Copy strokes and fills 

Use the Eyedropper tool to copy fill and stroke attributes from one object and immediately apply them to 

another object. The Eyedropper tool also lets you sample the image in a bitmap to use as a fill. 

1. To apply the attributes of a stroke or filled area to another stroke or filled area, select the 

Eyedropper tool and click the stroke or filled area whose attributes you want to apply. 

  

When you click a stroke, the tool automatically changes to the Ink Bottle tool. When you click a 

filled area, the tool automatically changes to the Paint Bucket tool with the Lock Fill modifier 

turned on. 

2. Click another stroke or filled area to apply the new attributes. 

Modifying painted areas with Paint Bucket tool 



The Paint Bucket tool fills enclosed areas with color. This tool lets you do the following: 

 Fill empty areas, and change the color of already painted areas. 

 Paint with solid colors, gradients, and bitmap fills. 

 Use the Paint Bucket tool to fill areas that are not entirely enclosed. 

 Have Animate close gaps in shape outlines as you use the Paint Bucket tool. 

1. Select the Paint Bucket tool from the Tools panel. 

2. Select a fill color and style. 

3. Click the Gap Size modifier that appears at the bottom of the Tools panel and select a gap size 

option: 

  

 Don’t Close Gaps to close gaps manually before filling the shape. Closing gaps manually can be 

faster for complex drawings. 

  

 A Close option to have Animate fill a shape that has gaps. 

  

 If gaps are too large, you might have to close them manually. 

4. Click the shape or enclosed area to fill. 

Paint Bucket tool options 

You can use Paint bucket tool to click and drag across the contours of an object to fill them with a chosen 

color. Click and drag the tool in any direction across the contours. Paint bucket tool fills the color 

wherever dots are captured across the contours. 

When you select the Fill all regions checkbox, all regions of selection are filled with the color while 

dragging. 

By default, the Fill all regions option is unchecked. In this mode, Paint Bucket tool fills only specific color.  

When Fill all regions is not selected (default) 

 In this mode, when a user clicks the mouse using paint bucket, you can notice the color that is being 

replaced. In this case, let us consider that green color is being replaced by red now. 

 As the user drags across artwork, this option replaces only the contours which are filled with that green 

color. 

 If the user drags across an empty closed contour, it is filled with red. 

 At the time of mouse click if the underlying contour was empty, then this option fills empty contours 

when the user drags the paint bucket tool. 

When Fill all regions is selected 

All the regions are filled with the selected color. In case of above mentioned illustration, it is red. 



Transform gradient and bitmap fills 

You can transform a gradient or bitmap fill by adjusting the size, direction, or center of the fill. 

1. Select the Gradient Transform tool   from the Tools panel. If you do not see the Gradient 

Transform tool in the Tools panel, click and hold on the Free Transform tool and then select the 

Gradient Transform tool from the menu that appears. 

2. Click an area filled with a gradient or bitmap fill. A bounding box with editing handles appears. 

When the pointer is over any one of these handles, it changes to indicate the function of the 

handle. 

  

Center point 

The rollover icon for the center point handle is a four-way arrow. 

  

Focal point 

The focal point handle appears only when you select a radial gradient. The rollover icon for the 

focal point handle is an inverted triangle. 

  

Size 

The rollover icon for the size handle (middle handle icon on the edge of the bounding box) is a 

circle with an arrow inside of it. 

  

Rotation 

Adjusts the rotation of the gradient. The rollover icon for the rotation handle (the bottom handle 

icon on the edge of the bounding box) is four arrows in the shape of a circle. 

  

Width 

Adjusts the width of the gradient. The rollover icon for the width handle (the square handle) is a 

double-ended arrow. 

Press Shift to constrain the direction of a linear gradient fill to multiples of 45°. 



 

Radial gradient controls 

A. Center point B. Width C. Rotation D. Size E. Focal point.  

3. Reshape the gradient or fill in any of the following ways: 

  

 To reposition the center point of the gradient or bitmap fill, drag the center point. 

 

 To change the width of the gradient or bitmap fill, drag the square handle on the side of the 

bounding box. (This option resizes only the fill, not the object containing the fill.) 

 

 To change the height of the gradient or bitmap fill, drag the square handle at the bottom of the 

bounding box. 



 

 To rotate the gradient or bitmap fill, drag the circular rotation handle at the corner. You can also 

drag the lowest handle on the bounding circle of a circular gradient or fill. 

 

 To scale a linear gradient or a fill, drag the square handle at the center of the bounding box. 

 

 To change the focal point of a circular gradient, drag the middle circular handle on the bounding 

circle. 



 

 To skew or slant a fill within a shape, drag one of the circular handles on the top or right side of 

the bounding box. 

 

 To tile a bitmap inside a shape, scale the fill. 

 

 To see all the handles when working with large fills or fills close to the edge of the Stage, 

select View > Pasteboard. 

Lock a gradient or bitmap to fill the Stage 

You can lock a gradient or bitmap fill to make it appear that the fill extends over the entire Stage and that 

the objects painted with the fill are masks revealing the underlying gradient or bitmap. 

When you select the Lock Fill modifier with the Brush or Paint Bucket tool and paint with the tool, the 

bitmap or gradient fill extends across the objects you paint on the Stage. 

 



Using the Lock Fill modifier creates the appearance of a single gradient or bitmap fill being applied to separate 

objects on the Stage. 

Use a locked gradient fill 

1. Select the Brush or Paint Bucket tool and select a gradient or bitmap as a fill. 

2. Select Linear or Radial from the Type menu in the Color panel. 

3. Click the Lock Fill modifier  . 

4. First paint the areas where you want to place the center of the fill, and then move to other areas. 

Use a locked bitmap fill 

1. Select the bitmap to use. 

2. Select Bitmap from the Type menu in the Color panel. 

3. Select the Brush or Paint Bucket tool. 

4. Click the Lock Fill modifier  . 

5. First paint the areas where you want to place the center of the fill, and then move to other areas. 

Shading techniques 

Shading is used traditionally in drawing for depicting a range of darkness by applying media 

more densely or with a darker shade for darker areas, and less densely or with a lighter shade for 

lighter areas. Light patterns, such as objects having light and shaded areas, help when creating 

the illusion of depth on paper.[2][3] 

There are various techniques of shading, including cross hatching, where perpendicular lines of 

varying closeness are drawn in a grid pattern to shade an area. The closer the lines are together, 

the darker the area appears. Likewise, the farther apart the lines are, the lighter the area appears. 

Powder shading is a sketching shading method. In this style, stumping powder and 

paper stumps are used to draw a picture. (This can be in color.) The stumping powder is smooth 

and doesn't have any shiny particles.  

 

https://en.wikipedia.org/wiki/Drawing
https://en.wikipedia.org/wiki/Shading#cite_note-2
https://en.wikipedia.org/wiki/Shading#cite_note-2
https://en.wikipedia.org/wiki/Hatching
https://en.wikipedia.org/wiki/Sketch_(drawing)
https://en.wikipedia.org/wiki/Stumping_powder
https://en.wikipedia.org/wiki/Stump_(drawing)
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